
Simcenter Femap
What’s New in 2306

© Siemens 2023 | Siemens Digital Industries Software | Where today meets tomorrow.



Simcenter Femap 2301 and Beyond Roadmap

© Siemens 2023 | Siemens Digital Industries Software | Where today meets tomorrow.

Femap v2022.1

December 2021

Femap v2022.2

April 2022

Femap 2301

January 2023

F Femap v2022.2 MP 1 

June 2022

Femap v2022.2 MP 2/MP 3 

August 2022/October 2022

M
M

Femap v2022.1 MP 1 

February 2022

M

Femap 2401

January 2024

Femap v2022.1 MP 2 

April 2022

M

F

F

Femap 2301 MP 1 

March 2023

Femap 2301 MP 2 

June 2023

M
M

F

F M

Femap 2306

July 2023

Femap 2306 MP 1

September 2023

Femap 2306 MP 2

November 2023

M



What’s new 

Simcenter Femap 2306

Teamcenter Integration

Geometry

Preprocessing

Meshing

Performance Improvements

Analysis and Solver Support

Postprocessing

Miscellaneous and API

© Siemens 2023 | Siemens Digital Industries Software | Where today meets tomorrow.



Simcenter Femap 2306
Teamcenter Integration
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Users can now specify 

multiple Teamcenter 

Server Environments via 

the PDM -> Teamcenter 

-> Sign In command

Server Definition items 

can be Added, 

Removed, Moved Up, 

and Moved Down in the 

Edit Teamcenter Server 

Environments dialog box

Once added, each 

server is then available 

in the drop-down



What’s new 

Simcenter Femap 2306

Teamcenter Integration

Geometry

Preprocessing

Meshing

Performance Improvements

Analysis and Solver Support

Postprocessing

Miscellaneous and API

© Siemens 2023 | Siemens Digital Industries Software | Where today meets tomorrow.



Simcenter Femap 2306
Geometry – CAD Data Translators
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CAD Data Translators migrated to Siemens standard 

PLMXML components, which offers:

• New Catia v6 translator! – Supports .3dxml file

• New Inventor translator! – Supports .ipt and .iam files

• New Rhino translator! – Supports .3dm file

• Catia v5 translator now part of the base product!

Benefits

• Same User Interface for all translators

• Standard Siemens PLMXML Components are well 

maintained

• Easier for FEMAP development to keep CAD translators 

up to date
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Simcenter Femap 2306
Preprocessing – Rotor Dynamics
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Simcenter Rotor Dynamics (SOL 414) is …

A dedicated solution to Rotor Dynamics 

analysis

• An established, recognized rotor dynamics 

technology, SAMCEF (ROTORS)

• Best-in-class and complete rotor dynamics 

capabilities

• Uses Simcenter Nastran input format

• Flexible modelling & smart solutions for 

industry-sized problems

• Dedicated streamlined workflows and 

scenarios

• Ease-of-use & short learning curve

• Tokenable solution (Enterprise Nastran)



Simcenter Femap 2306
Preprocessing – Rotor Dynamics
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Rotor Dynamics analysis in Simcenter Nastran 

(SOL 414) is now supported

New Element/Property Types

• Bearing

• Gear

• Fourier

New Rotor Dynamics Entity Types

• XY Plot Definitions

• Bearing Speeds

• Rotational Speeds

New Load Types

• Unbalance Mass

• Unbalance Moment



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Element/Property Types
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Bearing Element – writes CBEAR2 entry

• Defined by two nodes and a coordinate 

system

Bearing Property – writes PBEAR2 entry with 

TYPE field set to BEAR

• Constant stiffness, damping, and/or mass

• Option to have functionally-dependent 

stiffness, damping, and/or mass

• Rotor Speed – writes ROTF flag

• Frequency – writes FREQ flag

• Time – writes TIME flag

• Hysteretic Damping – writes HYST and 

corresponding value

• Proportional Damping – writes AVIS and 

corresponding value



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Element/Property Types
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Gear Element – writes CGEAR entry

• Defined as two nodes at center of two gears 

(separate rotors) and two coordinate 

systems

Gear Property – writes PGEAR entry

• Module of Gear – pitch diameter of gear 

divided by number of teeth

• Gear A/Gear B

• Number of Teeth – must be > 0

• Pitch Cone Angle – in degrees

• Helix Angle (deg)

• Pressure Angle (deg)

• Mesh Stiffness Coefficient (optional) – if not 

specified, gears are considered rigid



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Element/Property Types
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Fourier Element – writes FOU3 entry

• Connects a 3-D node with six DOF (Node A) to a 2-D node of a Fourier multi-harmonic 

(axisymmetric) element (Node B)

• Coupling Option – writes appropriate value to OPT field on FOU3 entry

• Translational (OPT = 1) – Nodes A and B must be coincident, translational DOFs are coupled

• Rigid Translational (OPT = 2) – Node A must be a symmetry axis and Nodes A and B must 

have the same axial coordinate which creates a rigid connection between the translational 

DOF of the 3D node and the Fourier node

• All DOFs (OPT = 5) – Similar to Rigid Translational, except all six DOFs are coupled, which 

allows the Fourier disk to deform (i.e., connection is not rigid)

• Can also be used in SOL 402

Fourier Property – none



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types
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The new Rotor Dynamics Entity Types 

can be access in two ways:

• Model -> Rotor Dynamics… menu

• In all cases, these commands 

display the dedicated Manager 

dialog box for the entity type

• Model Info tree – Context-sensitive 

menus for each entity type offer 

ability to:

• Create a New Entity

• Display Manager for Entity Type

• Copy Selected Entities

• Edit Selected Entities

• List Selected Entities

• Delete Selected Entities

• Renumber Selected Entities



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types

© Siemens 2023 | Siemens Digital Industries Software | Where today meets tomorrow.

XY Plot Definition – Defines an XY plot 

request for Nodal, Elemental, or Advanced 

output

• Writes both OUTMGT Case Control and 

corresponding OUTMGT Bulk Data entries

XY Plot Definition Manager

• New Nodal Plot

• New Elemental Plot

• New Advanced Plot 

• Edit Selected

• Show Selected

• Delete and Delete All

• Copy

• Renumber



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types
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Nodal XY Plot – writes NODE or NODGRP to TYPE 

field of OUTMGT Bulk Data entries along with 

corresponding values for other fields based on 

selected Components, Coordinate System, and 

Quantity

• Displacement (DISP)

• Velocity (VELOC)

• Acceleration (ACCEL)

• Reaction Force/Moment (REAC)

• Elliptic Orbit Parameters (ORBITP)

Elemental XY Plot – writes ELEM or ELEMGRP to 

TYPE field of OUTMGT Bulk Data entries along with 

corresponding values for other fields based on 

selected Components and Quantity

• Stress (STRESS – Top, Middle, and/or Bottom)

• Force (FORCE – Top, Middle, and/or Bottom)



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types
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Advanced XY Plot – writes ELEM or ELEMGRP to 

TYPE field of OUTMGT Bulk Data entries along with 

corresponding values for other fields based on 

selected items on Stiffness, Mass, Damping, and/or 

Results tabs in lower portion of dialog box 

Selected in Analysis Set Manager for available Rotor 

Dynamics Analysis Types 

• SOL 414,103 – Eigenvalue Analysis (Only when 

there is a transient response subcase)

• SOL 414,111 – Harmonic Analysis

• SOL 414,129 – Transient Analysis



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types
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Bearing Speed – Connect Rotor Regions to 

Bearings when Bearing Properties are 

speed-dependent (Dependency Type = 

“1..Rotor Speed”)

• Writes SPEBE2 Bulk Data entries which 

can be used with CBEAR2 which have the 

TYPE field on PBEAR2 set to BEAR or 

USER (not currently supported in Femap)

Bearing Speed Manager

• New Bearing Speed

• Edit Selected

• Show Selected

• Delete and Delete All

• Copy

• Renumber



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types
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Bearing Speed – individual SPEBE2 entry written for each 

Bearing element that is selected in Definition section

Speed Option section defines possible user inputs

• Select Rotor Region(s) – Select 1 or 2 rotors from the 

Rotor Specification section  

• Rotor Region 1 – writes ID to RID1 field

• Rotor Region 2 – writes ID to RID2 field

• Rotating in the Same Direction option

• When on, writes CORO to DIREC field

• When off, writes COUN to DIREC field

Note: If only single rotor is selected, DIREC field is ignored

• Specify Table – choose function in Bearing Speed section

• Writes ID of function to SPEED field

Note: DIREC field to be ignored, as bearing speeds are 

explicitly defined by function



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types
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Rotational Speed – Allows definition of 

rotation speeds in 3 different forms for use 

in Complex Modal analysis (SOL 414,110)

• Writes OMEGA, OMEGA1, or OMEGA2 

entries with appropriate values

• Rotational Speeds are selected via 

Select Rotational Speed(s) dialog box 

available only for subcases with Analysis 

Type set to “2..Rotor Complex Modal”

Rotational Speed Manager

• New Rotational Speed

• Edit Selected

• Show Selected

• Delete and Delete All

• Copy

• Renumber



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Entity Types
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Rotational Speed – entry written to input file depends on 

option selected for Variation Type in Definition section

• Individual Rotation Speeds (OMEGA) – writes OMEGA 

entry

• Values in Y column of Function selected in Rotational 

Speed Table section are written to Wi fields

• Linear Sweep (OMEGA1) – writes OMEGA1 entry 

• First Rotational Speed – value written to W1 field

• Rotational Speed Increment – value written to DW field

• Number of Increments – value written to NDW field

• Logarithmic Sweep (OMEGA2) – writes OMEGA2 entry 

• First Rotational Speed – value written to W1 field

• Last Rotational Speed– value written to W2 field

• Number of Increments – value written to NDW field



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Load Types

© Siemens 2023 | Siemens Digital Industries Software | Where today meets tomorrow.

The Model -> Load -> Nodal command 

can be used to create two new load 

types specific to Rotor Dynamics:

• Unbalance Mass

• Unbalance Moment

Both types:

• Require a Rotor Region be selected

• Allow a function to be specified as a 

Speed Table (option)

• Can only be used for SOL 414,111 

(Subcase only) or SOL 414,129 by 

selecting them via Boundary 

Conditions

• Are written to UNBA Bulk Data 

entries referenced by ULOAD Case 

Control entry in specified case



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Load Types
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Unbalance Mass

• Rotor Region – writes ID to RID field

• Speed Table – writes ID of function 

to SPEED field

• Mass – writes value to MASS field

• Eccentricity – writes value to ECC 

field

• Phase – writes value to PHASEF 

field

• Time/Freq Dependence – writes ID 

of vs Time function to VBAL field

Note: If values for MASS, ECC, and 

VBAL are all specified, MASS and ECC 

are ignored by solver



Simcenter Femap 2306
Preprocessing – Rotor Dynamics Load Types
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Unbalance Moment

• Rotor Region – writes ID to RID field

• Speed Table – writes ID of function 

to SPEED field

• Moment – writes value to MOMENT 

field

• Angle – writes value to THETA field

• Phase – value written to PHASEM 

field

• Time/Freq Dependence – writes ID 

of vs Time function to MBAL field

Note: If values for MOMENT, THETA, 

and VBAL are all specified, MOMENT 

and THETA are ignored by solver
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Simcenter Femap 2306
Meshing – Mesh -> Region Enhancement
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The Mesh -> Region command has 

been in Femap for a very long 

time, but was enhanced to a large 

extent for 2306

In previous versions, the node 

numbering needed to be in a very 

specific order for the command to 

create appropriate elements 

between the two sets of selected 

nodes (“Region 1” and “Region 2”)

In 2306, the only requirement that 

remains is that the same number of 

nodes be selected for “Region 1” 

and “Region 2”. 

2301 – Box Pick Regions 2306 – Box Pick Regions



Simcenter Femap 2306
Meshing – Mesh -> Region Enhancement
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Starting Model – No Geometry Regions Selected Vertical Middle Area



Simcenter Femap 2306
Meshing – Mesh -> Region Enhancement
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Mesh Fully Connected by using Mesh -> Region AgainHorizontal Gaps in Mesh Skipped
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Simcenter Femap 2306
Performance Improvements – Graphics

© Siemens 2023 | Siemens Digital Industries Software | Where today meets tomorrow.

Data Structures were defined and modified to allow Unified Graphics Architecture 

(UGA), first introduced in 2301, to be able to handle Nodes and Elements in an 

upcoming version

Improved performance of dynamic rotation in larger models which essentially had a 

property defined for each element in the model

• One example was a model that had 2 Million 10-noded tetrahedral elements and 2 

million properties which went from rotating at 5 frames/second to between 30-40 

frames/second on the same hardware (6X-8X improvement)
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Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Five new analysis types for Rotor Dynamics have been added for 

Simcenter Nastran

• “34..Rotor Dynamics Maneuvers” (SOL 414,101) – Linear static 

analysis with rotational forces

• “35..Rotor Dynamics Eigenvalue Analysis” (SOL 414,103) –

Compute modes of the rotating system at rest

• “36..Rotor Dynamics Complex Modal Analysis” (SOL 414,110) –

Find critical speeds and stability of rotating system

• “37..Rotor Dynamics Harmonic Response” (SOL 414,111) – Model 

rotating system under synchronous/asynchronous frequency-

dependent excitation

• “38..Rotor Dynamics Transient Response” (SOL 414,129) – Direct 

solution to model rotating system under time-dependent excitation 



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Much like other types of analysis, each type of Rotor 

Dynamics analysis requires specific inputs

New and updated dialog boxes available for all SOL 414 

analysis types include:

• NASTRAN Rotor Dynamics Options – New! 

• Rotor Modeling Assembly Selection – New!

• Boundary Conditions – Unique for Rotor Dynamics

Other new dialog boxes that may be used for specific type 

of SOL 414 analysis include:

• Select XY Plot Definition(s)

• Select Rotational Speed(s)



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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The NASTRAN Rotor Dynamics Options dialog box is used to 

specify the Rotor Dynamics Solution Options as well as 

Parameters used for certain types of analysis

Activate Rotor Dynamics Solution Options – when on, entries in 

specified in ROTORD section are written to input file

ROTORD section – writes first two lines of ROTORD entry

• Rotor Speed Variation Type – Used to limit available inputs 

for reference rotor speed

• “0..Constant” – reference rotor speed remains constant, 

thus only Start Value (RSTART) can be entered

• “1..Linear by Steps” (Default) – Enter values for Start 

Value (RSTART), Step Size (RSTEP), and Number of 

Steps (NUMSTEP) to define varying rotor reference speed

• “2..Function of a Sweeping Parameter” – Rotor speed 

defined in another manner (OMEGAi, FREQi, or TSTEPi)



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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ROTORD section – writes first two lines of ROTORD entry

• Start Value (RSTART) – value written to RSTART field

• Step Size (RSTEP) – value written to RSTEP field

• Number of Steps (NUMSTEP) – value written to 

NUMSTEP field

• Reference System (REFSYS) – Frame of Reference

• “0..Fixed” – specifies “fixed” frame of reference and 

writes ‘FIX’ to REFSYS field

• “1..Rotating” (Default) – specifies “rotating” frame of 

reference and writes ‘ROT’ to REFSYS field



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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ROTORD section – writes first two lines of ROTORD entry

• Rotor Speed Input Unit (RUNIT) – selects units for rotor 

speed input, written to RUNIT field

• “0..RPM – Revs/Min” (Default) – writes ‘RPM’ characters

• “1..CPS – Cycles/Sec” – writes ‘CPS’ characters

• “2..HZ – Hertz” – writes ‘HZ’ characters

• “3..RAD – Radians/Sec” – writes ‘RAD’ characters

• Whirl Direction Threshold (ORBEPS) – threshold value for 

detection of whirl direction written to ORBEPS field



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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ROTORD section – writes first two lines of ROTORD entry

• .f06 Output (ROTPRT) – controls output written to .f06 file by 

specifying value for ROTPRT field

• “0..None” (Default) – writes 0, prints nothing

• “1..Generalized Matrices” – writes 1, prints:

• Generalized matrices

• Final nonlinear bearing values at each frequency/time

• “2..Eigenvalue Summary/Eigenvectors” – writes 2, prints:

• Eigenvalue summary and eigenvectors at each RPM

• Intermediate nonlinear bearing values at each iteration

• “3..Both” – writes 3, prints combination of 1 and 2

• Freq Resp Analysis Type (SYNC) – option for frequency 

Response analysis

• 0..Asynchronous – writes value of 0 to SYNC field

• 1..Synchronous (Default) – writes value of 1 to SYNC field



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Parameters section

• FHPOST – Specifies the results output option when the 

axisymmetric Fourier elements are requested with the FHAR 

Case Control Command by writing PARAM,FHPOST

• “1..2D and 3D Results + 3D Recombination” – writes value 

of 1, which Requests 3D harmonic results for the 

axisymmetric Fourier elements at incremental angle 

locations around the complete 360 degree circumference by 

using FHPNST parameter to define the angle increments 

per 90 degrees. In addition, writes out all output requested 

by option “5..2D and 3D Results”

• “4..2D Results” – writes value of 4, which requests 2D 

results on the modeled axisymmetric geometry

• “5..2D and 3D Results” (Default) – writes value of 5, which 

requests 2D results on the modeled axisymmetric geometry 

and 3D results on the modeled solid element geometry



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Parameters section

• FHPNST – Specifies the number of angle increments in a 

90-degree quadrant in which the software computes the 3D 

harmonic results for axisymmetric Fourier elements, which 

allows users to view the non-axisymmetric results on a full 

revolute mode

• Writes PARAM,FHPNST with entered value

• Default value is 12, which is minimum value for FHPNST

• Used in conjunction with “1..2D and 3D Results + 3D 

Recombination” option specified for FHPOST

• DFREQ – Specifies threshold for the elimination of duplicate 

frequencies (or rotational speeds) on all FREQi (or OMEGAi) 

entries, by writing PARAM,DFREQ with entered value

• RDMTRAK – Specifies threshold value for mode tracking in 

SOL 414,110, writes PARAM,RDMTRAK with entered value



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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The Rotor Modeling Assembly Selection dialog box is 

used to select which Rotor Region(s) in model will be 

considered during the analysis, with minimum number 

of Rotors being 1 and maximum number being 10

Each Rotor #, Function, and Value combination is 

used to write lines 3 though 12, as needed, on the 

ROTORD entry

Rotor Region Selection section

• Rotor 1 through Rotor 10 – writes ID of selected 

Rotor Region to appropriate RIDi field

Note: Rotation Axis (Z Axis), Freq for Overall Damping 

(W3), Freq for Material Damping (W4), and Rotational 

Force Applied on Rotor Region are written to RCORDi, 

W3_i, W4_i, and RFORCEi fields, as needed



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Rotor Speed Multiplier section

• Function – when specified, writes ID of selected 

function to appropriate SPEEDi field as an integer

• If  Step Size (RSTEP) value in NASTRAN Rotor 

Dynamics Options dialog box is: 

• Non-Zero – defines values of the multiplier as a 

function of reference rotor speed

• 0 – defines values of the rotor speed as a 

function of the sweeping parameter with 

sweeping parameter specified as OMEGAi for 

SOL 414,110, FREQi for SOL 414,111, or 

TSTEPi for SOL 414,129

• Value – if function is not specified, writes value to 

appropriate SPEEDi field as real number, which is a 

multiplier of all reference rotor speeds



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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The Select XY Plot Definitions dialog box is used to 

select which XY Plot Definition entities will be 

written to the input file as OUTMGT entries

Available for:

• SOL 414,103 (Eigenvalue Analysis)

• SOL 414,111 (Harmonic Response)

• SOL 414,129 (Transient Response)

For convenience, this dialog box contains:

• Common icons used throughout Femap for 

selection and filtering of “named entities”

• Additional icons to highlight Nodes and Elements 

referenced by XY Plot Definition entities in the 

graphics window as well as create, edit, and 

delete XY Plot Definition entities



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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The Select Rotational Speeds dialog box is used to 

select which Rotational Speed entities will be 

written to the input file as OMEGA, OMEGA1, 

and/or OMEGA2 entries

Available for:

• SOL 414,110 (Complex Modal Analysis) once a 

Subcase with Analysis Type set to “2..Rotor 

Complex Modal” has been created

For convenience, this dialog box contains:

• Common icons used throughout Femap for 

selection and filtering of “named entities”

• Additional icons to create, edit, and delete 

Rotational Speed entities



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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The Boundary Conditions dialog box has 

been updated to add Load Sets and other 

options specific for SOL 414 Analysis Types

• Static Load Sets – used to select a load 

set containing static loads

• Dynamic Load Set – used to select a 

load set containing dynamic excitations

• Unbalance Load Set – used to select a 

load set containing Unbalance Mass 

and/or Unbalance Moment loads

• Fourier Multi-Harmonics (a,b,c THRU d) 

– used to request/remove certain 

harmonics for an analysis (text entry)



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Available Input Summary:

• Options section

• For all SOL 414 Analysis Types

• NASTRAN Executive and Solution Options

• NASTRAN Bulk Data Options

• NASTRAN Rotor Dynamics Options

• Rotor Modeling Assembly Selection

• For all SOL 414 except SOL 414,101

• NASTRAN Dynamic Analysis

• For all SOL 414 except SOL 414,101 and SOL 414,110

• Select XY Plot Definition(s)

• For SOL 414,129 Only

• Strategy Parameters (NLCNTLG) – Added Axisymmetric 

Harmonic Coupling Options specifically for this analysis type



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Available Input Summary:

• Global Requests and Conditions section

• For all SOL 414 Analysis Types

• Boundary Conditions

• NASTRAN Output Requests

• For SOL 414,129 Only

• Strategy Parameters (NLCNTL2)



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Available Input Summary (Subcase):

• For all SOL 414 Analysis Types

• Analysis Case – see specific SOL 414 analysis types

• Boundary Conditions

• NASTRAN Output Requests

• For SOL 414,101 (Maneuvers)

• Analysis Case – No Analysis Types – No additional 

dialog boxes

• For SOL 414,103 (Eigenvalue Analysis)

• Analysis Case – 3 Analysis Types:

• “1..Static Loads, Constraints”

• “2..Rotor Eigenvalues” – NASTRAN Modal Analysis

• “3..Transient Preload” – Strategy Parameters 

(NLCNTL2) and Subcase # Time Step



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – Rotor Dynamics
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Available Input Summary (Subcase):

• For SOL 414,110 (Complex Modal Analysis)

• Analysis Case – 2 Analysis Types

• “1..Static Loads, Constraints”

• “2..Rotor Complex Modal” – NASTRAN Modal 

Analysis and Select Rotational Speed(s)

• For SOL 414,111 (Harmonic Response)

• Analysis Case – 2 Analysis Types:

• “1..Static Loads, Constraints”

• “4..Rotor Harmonic” – NASTRAN Dynamic Analysis, 

NASTRAN Modal Analysis, and Strategy Parameters 

(NLCNTL2)

• For SOL 414,129 (Transient Response)

• Analysis Case – No Analysis Types – Strategy 

Parameters (NLCNTL2) and Subcase # Time Steps



Simcenter Femap 2306
Analysis and Solver Support – Simcenter Nastran – SOL 402
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Updated name of “Control Options” in Analysis Set 

Manager tree structure to “Strategy Parameters”

Changed name of dialog box to “Strategy Parameters 

(NLCNTL2)” and enhanced it to feature tabs (formally):

• Analysis (Analysis Control – 2 places)

• Plasticity/Creep (Plasticity and Creep Control)

• Time Integration (Time Integration)

• Equilibrium (Equilibrium Iteration and Convergence)

• Time Stepping (Time Stepping and Viscous Material 

Options)

• Contact (Contact)

• Other (Internal Restart and Diagnostic)

Added Default Tab and Default All buttons
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Additions and Updates for Multi-Step Kinematics (SOL 402) in Analysis Set Manager

• Strategy Parameters (NLCNTL2) – Analysis tab

• Added Store Run Option (ISTO) drop-down

• Added Solution Method (IRDY) drop-down

• Added Solution Frequency Option (BALF) drop-down

• Strategy Parameters (NLCNTL2) – Equilibrium tab

• Added Relaxed Force Tol (PRDR) value

• Added Relaxed Energy Tol (PRDE) value

• Strategy Parameters (NLCNTL2) – Other tab

• Added Storage Cycle for Element Stress (IA4) value

• Added Complex Eigenvalue Frequency Step (IA12) value

• Strategy Parameter (NLCNTLG)

• Added Check Initial Stiffness (KINI) option – can be used in SOL 414 as well
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Updated name of “Control Options” in Analysis Set 

Manager tree structure to “Strategy Parameters”

Changed name of dialog box to “Strategy Parameters 

(NLCNTL2)” and enhanced it to feature tabs (formally):

• Analysis (Analysis Control – 2 places)

• Plasticity/Creep (Plasticity and Creep Control)

• Time Integration (Time Integration)

• Equilibrium (Equilibrium Iteration and Convergence)

• Time Stepping (Time Stepping and Viscous Material 

Options)

• Contact (Contact)

• Other (Internal Restart and Diagnostic)

Added Default Tab and Default All buttons
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Added support for Simcenter Nastran’s ability to use the 

Relative Method instead of the Large Mass Method for 

Base DOF

Relative Method – writes RSPLOC entry 

• RSPLOC Set – Constraint set containing nodes where 

spectrum is to be applied by writing nodes constrained 

in any DOF to the GIDi fields

• CSys – writes ID of coordinate system to CID field

• Direction – integer corresponding to selected option 

written to DIR field

When used, ID of RSPLOC is then written to a RSPLOIDi

field on the RSAPPLY entry (support added in Femap 

2301)
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Analysis and Solver Support – Nastran and ABAQUS
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Simcenter Nastran and MSC Nastran

• Added support to write/read Femap Layup Titles to/from comments in input files

• Added support to write 0.0 for stiffness values to Spring/Damper properties (“K” values 

on PBUSH) as this is viable for these solvers

ABAQUS

• Improvements to exporting load and constraint definitions

• Consistently create *NSET and *ELSET from load definitions and constraint definitions

• Create accurate *NSET and *ELSET for load definitions and constraint definitions 

applied on different geometric entities such as points, curves, and/or surfaces

• Appropriately export load Definitions on elements, curves, and points are as *CLOAD 

and *DLOAD

• *NSET and *ELSET are referenced in *BOUNDARY, *CLOAD, and *DLOAD to reduce 

input file size

• Improvements to exporting and importing *TIE keyword
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Analysis and Solver Support – Analysis Set Manager
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Analysis Set Manager

Added Non-Default Values branch under Strategy 

Parameters which only displays non-default values 

specified in the Strategy Parameters (NLCNTL2) 

dialog box for Analysis Types:

• “28..Multi-Step Nonlinear Kinematic” (SOL 402) 

• “38..Rotor Dynamics Transient Response” (SOL 

414,129)

Note: Similar functionality is planned for other 

Analysis Types in future releases, beginning with 

“27..Multi-Step Structural” (SOL 401)



What’s new 

Simcenter Femap 2306

Teamcenter Integration

Geometry

Preprocessing

Meshing

Performance Improvements

Analysis and Solver Support

Postprocessing

Miscellaneous and API
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Simcenter Femap 2306
Postprocessing – Support for results from Simcenter Nastran SOL 414 analysis types
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Overview of working with results 

generated by Simcenter Nastran 

SOL 414 analysis

• VERY IMPORTANT: SOL414 

does NOT generate an OP2 

results file​, thus support was 

added for attaching to 

the Simcenter Data File 

(SCD5) generated by SOL 414​

• SCD5 is based on the HDF5 

file format

• SCD5 is the only output file 

which can currently be 

used for post-processing 

SOL414 results in Femap​



Simcenter Femap 2306
Postprocessing – Support for results from Simcenter Nastran SOL 414 analysis types
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The SCD5 results file contains two 

types of results which are stored in 

Femap:

• Results for nodes/elements 

which are stored within Output 

Sets as Output Vectors which 

can be plotted in the graphics 

window

• Typically, the results from SOL 

414 are displayed a contoured 

plot, either deformed or 

animating, based on options 

specified in Complex Results 

dialog box



Simcenter Femap 2306
Postprocessing – Support for results from Simcenter Nastran SOL 414 analysis types
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The SCD5 results file contains two types 

of results which are stored in Femap:

• Results in XY format which are stored 

as Femap functions which can be 

viewed in the Charting pane​

• Typically, specific functions are 

selected to generate a “Campbell 

Diagram”, which can be used to 

determine critical speeds, among 

other things.

• Lines with 2 points originating at 0,0 

are 0P (Green) and 2P (Cyan)

• All other lines are “EigenFrequency vs 

Rotation Speed” for various modes
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Simcenter Femap 2306
Miscellaneous – Command Finder Enhancements
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Command Finder Enhancements

• Search now includes commands found in 

Dockable Panes

• If selected command is located within a 

Pane, the Pane becomes visible

• If selected command is located with a 

particular “Tool” within a “Toolbox”, that tool 

will be opened and “pulsate” a few times to 

draw user’s attention

• Search now includes “keywords” which are 

known to be the nomenclature found in other 

CAE applications

• For instance, “Equivalence” and “Grids”



Simcenter Femap 2306
Miscellaneous – Digital Product Experience & Product Excellence Program 
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Help Improve the Femap Experience by choosing 

Program Enrollment options in Help -> Data Privacy

Enhancements to comply with new data privacy laws

Femap collects information about how our customers use 

the product to help improve product features and user 

experience

• No proprietary or personally identifiable information is 

collected

• Participation is completely optional

• Does not affect product performance



Added GeometryInterface Object to provide access to all Geometry translators using a 

single Object

Rotor Dynamics

• Added Objects for new Rotor Dynamics entity types (XY Plot Definition, Bearing Speed 

Definition, and Rotational Speed Definition)

• Updated Element and Property Objects to support Bearing, Gear, and Fourier 

Element/Property types

• Updated Analysis Manager and Analysis Case Objects for new options, dialog boxes, 

etc

• Updated LoadMesh Object for unbalance loads

Simcenter Femap 2306
API – New functionality
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Added feFileMessageSelectAll, feFileMessageClear, and feFileMessageSave2 to perform 

actions in the Messages dockable pane

Added feSurfaceRuled2 to access all available options of the Geometry -> Surface -> 

Ruled / Between Curves command

Added feMeshSizeSurface2 to access all available options of the Mesh -> Mesh Control -> 

Size On Surface command

Added Pref_ViewLogoTransparent to set the “Transparent Logo” option on the “Views” tab 

of File -> Preferences

Simcenter Femap 2306
API – New functionality
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www.femap.de

Try Simcenter Femap for free
30-day free trial
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Explore – Browse our different blogs
dedicated to each solution, read our 

articles and hear about the latest news.

Share – Ask questions in our forum, 

get answers, connect with other users, 

and benefit from their experience.

Learn – Find the information you need 

in the knowledge base and 

improve your skills.

Join the Simcenter Femap Community

siemens.com/plm/community/simcenter
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